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Upload Wizard (South Dakota)

PATH: SD State Reporting > Upload Wizard

Districts that do not use the Infinite Campus District Edition to manage their district data can use the State
Edition Upload tool to upload files containing their district's student information to the State System. Files
uploaded with the tool must conform to the File Specifications noted in the following information.

This article includes the following topics:

Understanding the Upload Wizard

File Specifications

School Calendar Upload Specifications
School Days Upload Specifications

Student Demographic Upload Specifications
Enroliment Upload Specificiations

Codes and Descriptions

Upload Wizard
Select the file you wish to upload to the Campus server and the type of load you want to perform

Select an option under "Work To Perform™ to indicate how the file should be processed. There are 3 options:

1. Validate and Test File - Onhy error checking will be performed on the file. A summary report will be generated
identifying any errors that were found. No data is imported under this option.

2. Load Partial File - Data frem the file will add to or update the current student record. & summary report
will be generated indicating the number of records that were inserted or changed and any errors. This option
zhould be uzed when updating the information on a partial list of students.

. Load Complete File - CAUTION Data imperted from this file will replace all existing data from the calendars
included in the file. A summary report will be generated indicating the number of records that were changed or
deleted. This option iz useful for deleting any data that was previoushy entered and replacing it with the
contents of the uploaded file.

Work to Perform | validate and Test File »
File

[ Browse_ ][ Upload ]

Result File P

1 To use the tool, users must have tool rights to Upload Wizard tool. Users must have their user
account set to the district that they are trying to upload into or must have state-wide district rights.

Prior to uploading a file, a calendar for the current year and all required grade levels for that calendar
must be setup within the SD State Edition user interface. If this is not done, an error message will be
displayed when an upload is attempted.

Additionally, the upload tool assumes that a School/Year has only one calendar and one schedule
structure defined within the State Edition. If multiple calendars or schedule structures are created for that
school/year, an error will display when an upload is attempted.
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Understanding the Upload Wizard

The Upload Wizard provides three actions that can be selected:

Action

Validate
and Test

Load
Partial

Load
Complete

Description

In this mode the file will be uploaded and all data validation will be performed to ensure
that the file conforms to the file specifications section. Additionally, a search will be
performed on the District, School and Student Number to make sure the named District,
School and Students actually exist. No data will change as a result of this action. A report
will be generated listing errors and their corresponding line numbers and fields of error.

This mode will insert or update data for each record from the file that has no errors. If a
row has an error, it will be displayed in the report generated after the upload completes.

When inserting new data, such as at the beginning of a school year, each student record
in the file will create a new enrollment record.

When updating data that already exists, the enroliment start date will be used to match the
enrollment that should be updated. If an enrollment with a matching start date is not
found, a new enrollment will be created.

When updating the dated enrollment fields Meal Status and Title 1, the dated record that
will be changed is the one with an effective date matching the enrollment start date. If
none can be found, a new record with that date is created.

When updating the dated fields, SPED, Special Ed Program, Special Ed Category and
Disability, the dated field will be matched to existing SPED data within the enrollment
based on the Special Ed Start Date field. If a SPED record with that start date cannot be
found, a new record is created with that Special Ed start date.

In addition to Validating and Testing, the Load Complete mode will erase all student data
from calendars named in the upload file. After that, the records in the file are inserted as
new enrollments. This mode should be used if a complete refresh of the data is required.
It should not be used if any data has been manually edited through the user interface as
that data will be lost.

1 This will remove all existing data.

Uploading Files

1. Select the appropriate action as defined above in the Work to Perform dropdown list.

2. Locate the file to upload by selecting the Browse button in the File field. Follow the instructions for
uploading and click the Upload button.

3. Or, select a file from the Result File dropdown and click the Load button.

The file will be processed and a verification of the upload will be returned.
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Resaults:
File Name: 04002_12012006_SD.tsv
Processing Started Time: Wed Aug 18 13:52:04 CDT 2010.
Processing Finished Time: Wed Aug 18 13:52:04 CDT 2010.
Total Time To Process File: 0 seconds.

0 Records Inserted.
0 Records Changed.
0 Records Deleted.

A fatal exception occurred preventing the file from being completely loaded. See Errors for details.

Error Count:1
Warning Count:0

Error Detail:
Line Number Error Message Content
1 Bad header data length in field ‘Record Type'. column 1. Field can be at most 2 characters and must be at least 2 characters. HD 12/01/2006 23:00:00 SD2.0

Warning Detail:
Line Number Warning M ge Content
No Warnings

Image 2: Upload Confirmation

(D Not all fields are automatically overwritten at the state level. When Homeless, First Year in
Country, Parent Does not want Meal Status shared with DSS, Meal Status or any type of
Title 1 fields are not null at the state level but no or null at the district level, a message will appear
when a status change is attempted indicating that a status that is not No or Null exists and should
not be overwritten.

The Enrollment Upload will create split fields with the date of the Enroliment Report Upload for
Meal Status (if the status is changed from F or R to Standard) and any Title 1 status (if changed
from Yes to No), with a warning message indicating that the student record was successfully
imported and a new record was created.

File Specifications

Files should follow the proper naming conventions and record definitions defined below:

All files will be tab delimited with a header record.

If a field is not required it can be left blank, but the proper number of tabs must be in each record.
All dates within the file will be in the format MM/DD/YYYY.

Times within the file will be displayed in military (24 hour) time HH:MM:SS such as 23:00:00 for
11:00pm.

File Name

Files must be named with the district number (maximum of 5 digits), underscore, date underscore and
record type with the extension *.tsv. Forward slashes are not allowed in file names and should be left out.

Example:

District 10063 submitting a Student Demographics file on 12/01/2006 would name the file:
10063 _12012006_SD.tsv
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Header Record

The first line of all files will be the header record. This is required.

Name
Record Type
Date

Time

Version

Length
2

01

8

15

Example Record:

Code/Format
“HD”
MM/DD/YYYY
HH:MM:SS
“SD2.0”

Description

Always the value “HD”
Date report was generated
Time report was generated

Always the value “SD2.0”

Header record submitted on December 1, 2006 at 11:00 pm:

HD 12/01/2006 23:00:00SD2.0

School Calendar Upload Specifications

This record defines each School Calendar or track a school is running. There should be at least 1 record
per school. There can be multiple records per school if the school has students receiving instruction on

different days or for different durations. If the school has multiple calendars, each calendar must be given
a distinct Calendar Number.

Element
Name

Record
Type

District
Number

School
Number

Description

Type of record being
generated.

State-assigned district
identification number.

State-assigned school
identification number.

Type, Format Campus Database

and Length

Alphabetic, 2 Not dynamically stored

characters

Always the
value of "SS"

Numeric, 5 District.number

digits

Numeric, 2 School.number

digits

6
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Campus
Interface

Not
dynamically
stored

System
Administration
> Resources
> District
Information >
District
Number

System
Administration
> Resources
> School >
State School
Number



Year The end year of the Date field, 4 Calendar.endYear System
calendar (i.e. for 2006-2007  characters Administration
= 2007). > Calendar >

YYYY Calendar >
Calendar Info
> End Date

Calendar Number assigned to the Numeric, 3 Calendar.number System

Number  calendar. Needs to match digits Administration
calendar number in > Calendar >
associated Calendar >
SD-Extract-School Calendar Calendar ID
file.

Calendar The type of calendar for Alphanumeric, Calendar.type System

Type which information is being 1 character Administration
reported. If the value being > Calendar >
imported is not a valid Calendar >
option, a warning will Type
appear. If data already
exists but the import file
does not have a value
entered, the existing value
will not be overwritten.

See the School Calendar
Extract article for a list of
options.

Student  The number of minutes of Numeric, 3 Calendar.studentDay System

Day instruction in the typical digits Administration
student day. > Calendar >

Calendar

4 Day Indicates a 4 Day School Alphanumeric, Calendar.alternativeCode System

School Week. 1 character Administration

Week > Calendar >

Y or N Calendar

Example Records:

An elementary school (0120) grades 1through 6 that attend 360 minutes of instruction per day and has
half-day Kindergarten that attends 180 minutes of instruction per day and starts on a different date then
the other grades.

SS 63 20071360Y
SS 631202007 2180Y

School Days Upload Specifications

This record defines when a school is open and when it provides instruction to students. There should be
1 record per date per School Calendar record within the date range that the school is open.

7
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Element
Name

Record
Type

District
Number

School
Number

Year

Calendar

Number

Date

Instructional
Day

School Day

Description

Type of record being generated.
In this case, always a value of
"DY".

State-assigned district
identification number.

State assigned school
identification number

The end year of the calendar (
i.e. for 2006-2007 = 2007).

Number assigned to the
calendar. Needs to match
calendar number in associated
SD-Extract-School Calendar
file.

A day record for each day in the
calendar

Indicates whether instruction
was given to students on this
date.

Indicates if the school was open
on this date (i.e. teacher
in-service day will have
Instruction = N and School Day
=Y).

Type, Format
and Length

Alphabetic, 2
characters

DY

Numeric, 5
digits

Numeric, 2
digits

Date field, 4
characters

YYYY

Numeric, 3
digits

Date field, 10
characters

MM/DD/YYYY

Alphabetic, 2
characters

Y orN

Alphabetic, 2
characters

Y orN
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Campus
Database

Not dynamically
stored

District.number

School.number

Calendar.endYear

Calendar.number

Day.date

Day.instruction

Day.schoolDay

Campus
Database

Not
dynamically
stored

System
Administration
> Resources
> District
Information >
District
Number

System
Administration
> Resources
> District
Information >
State School
Number

System
Administration
> Calendar >
Calendar >
Calendar Info

System
Administration
> Calendar >
Calendar >
Number

System
Administration
> Calendar >
calendar >
Days > Date

System
Administration
> Calendar >
Calendar >
Days >
Instruction

System
Administration
> Calendar >
Calendar >
Days >
School Day



Attendance Indicates if there is attendance Alphabetic, 2  Day.attendance System
Day for this day. characters Administration
> Calendar >
YorN Calendar >
Days >
Attendance

Day Number of minutes of Numeric, 3 Day.duration System

Duration instruction offered on this day. digits Administration
> Calendar >
Calendar >
Days >
Duration

Example Records:

The week of April 22, 2007 to April 28, 2007 has instruction starting Monday and continuing through
Thursday, with a teacher in-service day on Friday; its records would look like:

DY 63 2007 1 04/22/2007 NN N O
DY 63 2007 1 04/23/2007 Y Y Y 360
DY 63 120 2007 1 04/24/2007 Y Y Y 360

DY 63 120 2007 1 04/25/2007Y Y Y 360

DY 63 120 2007 1 04/26/2007 Y Y Y 360
DY 63 120 2007 1 04/27/2007 N Y N 0
DY 63 120 2007 1 04/28/2007 N N N 0

Student Demographic Upload Specifications

This record format contains basic student demographics fields. Typically there should be one record per
student. The exception for this is when a student’'s name or identifying information changes while at a
district. The state needs to maintain a history of all name changes for students, and the effective date
controls when this name was used.

When a new identity is created for a person, existing information in the Person Information area of the
Demographics tab is not deleted for the following fields:

Social Security Number
Birth Country

Date Entered US

Date Entered US School
Date Entered State School
Birth Verification
Nickname

Comments

Element Description Type, Format Campus Database Campus
Name and Length Interface
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Record Type

District
Number

State ID

Last Name

First Name

The type of record
being generated. In
this case, always
the value of "SD"
for student
demographics.

State-assigned
district
identification
number.

State identification
number assigned
to students.

When importing in
the State Edition, if
the State ID does
not match any
person, a new
person is created
and a new State ID
is created. The
State ID in the file
is not imported.

When importing in
the District Edition,
if the State ID is
null, the record is
ignored and not
imported. If the
State ID exists in
the file but does
not match a
person, an error
message is
produced and the
record is not
imported.

Student's legal last
name

Student's legal first
name

Alphabetic, 2
characters

SD

Numeric, 5
digits

Numeric, 9
digits

Alphanumeric,
40 characters

Alphanumeric,
35 characters

10

Not dynamically stored

District.number

Person.
studentNumber

Identity.lastName

Identity.firstName

Transforming K12 Education®

Not dynamically
stored

System
Administration >
Resources >
District
Information >
District Number

Census >
People >
Demographics >
Person
Identifiers >
Student State ID

Census >
People >
Demographics >
Last Name

Census >
People >
Demographics
> First Name



Middle Name

Suffix

Gender

Birth Date

Race
Determination

Hispanic
Indicator

American
Indian or
Alaska Native

Asian

Student's legal
middle name.

Suffix attached to
student's legal
name. Accepts Jr.
and SR. with or
without
punctuation.

Student's gender

Student's date of
birth

Code indicating
how student race
was determined.

Valid options
include:

® (01: Parent
Identified

® 02: Self
Identified

® 03: Observer
Determined

® 04: Unknown

Indicates if student
is Hispanic/Latino.

Indicates if student
is American Indian
or Alaska native.

Indicates if student
is Asian

Alphanumeric,
20 characters

Alphanumeric,
3 characters

Alphabetic, 1
cahracter

MorF

Date field, 10
characters

MM/DD/YYYY

Numeric, 2
digits

Numeric, 1
digits

Alphanumeric,
1 digit

Y orN

Alphanumeric,
1 digit

Y orN

11

Identity.middleName

Identity.suffix

Person.gender

Identity.birthDate

Identity.

raceEthnicityDetermination

Identity.
hispanicEthnicity

Identity.
raceEthnicity

Identity.
raceEthnicity

Transforming K12 Education®

Census >
People >
Demographics >
Middle Name

Census >
People >
Demographics >
Suffix

Census >
People >
Demographics >
Gender

Census >
People >
Demographics >
Birth Date

Census >
People >
Demographics >
Race
Determination

Census >
People >
Demographics >
Race/Ethnicity >
Edit > Is the
individual
Hispanic/Latino?

Census >
People >
Demographics >
Race/Ethnicity >
American Indian
or Alaska Native

Census >
People >
Demographics >
Race/Ethnicity >
Asian



Black or
African
American

Native
Hawaiian or
Other Pacific
Islander

White

Example Record

Indicates if student
is Black or African
American

Indicates if student
is Native Hawaiian
or Other Pacific
Islander.

Indicates if student
is White

S:

A student record for Joe Smith,

SD 63

Common errors:

® Gender or Race/Ethnicity left blank (data is required for these fields)

Alphanumeric,
1 digit

Y orN

Alphanumeric,
1 digit

Y orN

Alphanumeric,
1 digit

Y orN

Smith Joe Alan

Identity.
raceEthnicity

Identity.
raceEthnicity

Identity.
raceEthnicity

M

03/01/1997

Census >
People >
Demographics >
Race/Ethnicity >
Black or African
American

Census >
People >
Demographics >
Race/Ethnicity
>Native
Hawaiian or
Other Pacific
Islander

Census >
People >
Demographics >
Race/Ethnicity >
White

05

* Field names included in file (please remove all field names, such as legal entity number, gender,
race/ethnicity, etc.).

¢ Date Fields must be in a MM/DD/YYYY format (e.g. 03/07/1999).

® Fields with no information still require a tab.

Enrollment Upload Specificiations

This record contains information for the student enrollment. Typically there should be one record per
student enrollment. For your file name, the record type is EN.

Header Record

Name
Record Type
Date

Time

Version

Length Code/Format
2 “HD”

10 MM/DD/YYYY
8 HH:MM:SS
15 “SD2.0”

Description

Always the value “HD”
Date report was generated
Time report was generated

Always the value “SD2.0”

12
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Enrollment Record

Name

District Number

School Number

Calendar
Number

First Name

Middle Name

Last Name

Birth date

Gender

Description

State-assigned
district
identification
number.

State-assigned
school
identification
number.

Number assigned
to the calendar.
Needs to match
calendar number
in associated

SD-Extract-School

Calendar file.

Student's legal
first name.

Student's legal
middle name.

Student's legal
last name.

Student's date of
birth.

Student's gender.

Type, Format
and Length

Number, 5
digits

Number, 2
digits

Number, 3
digits

Alphanumeric,
35 characters

Alphanumeric,
20 characters

Alphanumeric,
40 characters

Date field, 10
characters

MM/DD/YYYY

Alphabetic, 1
character

MorF

13

Campus Database

District.number

School.number

Calendar.number

Identity.firstName

Identity.middleName

Identity.lastName

Identity.birthdate

Person.gender

Transforming K12 Education®

Campus
Interface

System
Administration >
Resources >
District
Information >
District Number

System
Administration >
Resources >
School > State
School Number

System
Administration >
Calendar >
Calendar >
Number

Census > People
> Demographics
> First Name

Census > People
> Demographics
> Middle Name

Census > People
> Demographics
> Last Name

Census > People
> Demographics
> Birth Date

Census > People
> Demographics
> Gender



Race
Determination

Hispanic
Indicator

American
Indian or
Alaska Native

Asian

Black or African
American

Native Hawaiian
or Other Pacific
Islander

White

State ID
Number

Code indicating
how student race
was determined.

Valid options
include:

®* 01: Parent
Identified

® 02: Self
Identified

® (03: Observer
Determined

® 04: Unknown

Indicates if
student is
Hispanic/Latino.

Indicates if
student is
American Indian
or Alaska native.

Indicates if
student is Asian.

Indicates if
student is Black or
African American.

Indicates if
student is Native
Hawaiian or Other
Pacific Islander.

Indicates if
student is White.

Student's state ID
number.

Numeric
digits

Numeric
digit

Numeric
digit

Numeric
digit

Numeric
digit

Numeric
digit

Numeric
digit

Numeric
digits

, 2 Identity.race
EthnicityDetermination

1 Student.hispanicEthinicity

1 Student.raceEthnicity

1 Student.raceEthnicity

, 1 Student.raceEthnicity

1 Student.raceEthnicity

1 Student.raceEthnicity

, 9 Person.studentNumber
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Census > People
> Demographics
> Race
Determination

Census > People
> Demographics
> Race/Ethnicity >
Edit > Is the
individual
Hispanic/Latino?

Census > People
> Demographics
> Race/Ethnicity >
American Indian
or Alaska Native

Census > People
> Demographics
> Race/Ethnicity >
Asian

Census > People
> Demographics
> Race/Ethnicity >
Black or African
American

Census > People
> Demographics
> Race/Ethnicity
>Native Hawaiian
or Other Pacific
Islander

Census > People
> Demographics
> Race/Ethnicity >
White

Census > People
> Demographics
> Person
Identifiers >
Student State ID



Social Security
Number

Grade Level

Resident
District Number

Attending
District Number

Enrollment
Start Date

Enrollment End
Date

Service Type

Percent
Enrolled

Student's Social
Security number.

Student grade
level

The identification
number of the
district in which
the student
resides.

The identification
number of the
district in which
the student
attends school.

The day student
enroliment began.

The day student
enrollment ended.

Indicates type of
service student is
receiving.

See Service Type
Codes Table

below.

Percentage of
time student was
enrolled in the
service, between
0 and 100.

Numeric, 9
digits

Alphanumeric,
2 characters

Numeric, 5
digits

Numeric, 5
digits

Date field, 10
characters
MM/DD/YYYY

Date field, 10
characters
MM/DD/YYYY

Alphabetic, 1
character

Numeric, 3
digits

15

Student.ssn

Enroliment.grade

Enrollment.residentDistrict

Enrollment.servingDistrict

Enrollment.startDate

Enrollment.endDate

Enrollment.serviceType

Enrollment.
percentEnrolled

Transforming K12 Education®

Census > People
> Demographics
> Social Security
Number

Student
Information >
General >
Enrollment >
Grade

Student
Information >
General >
Enrollments >
State Reporting
Fields > Resident
District

Student
Information >
General >
Enrollments >
State Reporting
Fields > Serving
(Attending)
District

Student
Information >
General >
Enrollments >
Start Date

Student
Information >
General >
Enrollments >
End Date

Student
Information >
General >
Enroliments >
Service Type

Student
Information >
General >
Enrollments >
State Reporting
Fields > Percent
Enrolled



Start Status

End Status

County Number

Enrollment
Status

The reason for the
student's entry
into the school.

Reason student
enrollment was
ended. If
Enroliment End
Date is supplied,
an End Status
must be entered.
See options in the
South Dakota
Enrollments Tab
article.

State defined
county number or
code.

Status of the
student's
enrollment. If
Resident District
and Attending
District are not the
same, an
Enroliment Status
must be selected.
If Resident District
and Attending
District are the
same, only codes
A and D are
available. If the
districts differ,
codes B, C, E, G,
J, M, O, P, Tand
W are available.

See Enrollment
Status Codes
Table below.

Numeric, 2 Enrollment.startStatus
digits

Numeric, 2 Enrollment.endStatus
digits

Numeric, 2 County.number

digits

EnrollmentSD.
enrolimentStatus

Alphanumeric,
1 character

16
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Student
Information >
General >
Enrollments >
General
Enrollment
Information >
Start Status

Student
Information >
General >
Enrollments >
End Status

Student
Information >
General >
Enrollments >
County

Student
Information >
General >
Enrollments >
State Reporting
Fields >
Enrollment Status


https://community.infinitecampus.com/kb/display/DOC/South+Dakota+Enrollments+Tab
https://community.infinitecampus.com/kb/display/DOC/South+Dakota+Enrollments+Tab

LEP

Primary
Language

LEP Date

Gifted

504 Plan

Indicates student
is participating in
LEP
programming.

If the current date
falls within the
Identified Date
and Exit Date
entered on the
LEP tab, a value
of Y is reported.
Otherwise, a
value of N is
reported.

Primary language
the student
speaks. If LEP =
Y, Primary
Language must
not be empty.

See options in the
South Dakota
Language Codes
article.

The date on which
the student began
participation in the
English
proficiency
program.

If the LEP column
reports a value of
Y, this field will
report the
Identified Date

Indicates if the
student is
considered gifted.

Indicates if the
student has a 504
Plan.

Alphabetic, 1
character

Y or N

Alphanumeric,
3 characters

Date field, 10
characters

MM/DD/YYYY

Alphanumeric,
1 character

Y or N

Alphanumeric,
1 character

Y or N

17

Enrollment.lep

Enrollment.language

Enrollment.english
ProficiencyDate

Enrollment.giftedTalented

Enrollment.section504

Transforming K12 Education®

Student
Information >
General > LEP >
Program Status

Census > People
> |dentities >
Home Primary
Language

Student
Information >
General > LEP >
Identified Date

Student
Information >
General >
Enrollments >
State Reporting
Fields > Gifted

Student
Information >
General >
Enrollments >
State Reporting
Fields > 504 Plan


https://community.infinitecampus.com/kb/pages/viewpage.action?pageId=5341187

Special Ed
Category

Occupational
Therapy Hours

Physical
Therapy Hours

Psychological
Therapy Hours

Counseling
Hours

Social Work
Hours

Code indicating
category into
which student's
special education
program
participation fits. If
Special Ed
Category is
entered, Special
Ed Start Date
must not be
empty.

See Special Ed
Category Codes

Table below.

Number of hours
student
participated in
occupational
therapy. Round to
3 decimals.

Number of hours
student
participated in
physical therapy.
Round to 3
decimals.

Number of hours
student
participated in
psychological
therapy. Round to
3 decimals.

Number of hours
student
participated in
counseling
services. Round
to 3 decimals.

Number of hours
student
participated in
social work
services. Round
to 3 decimals.

Numeric, 8

digits

Decimal, 8
digits

Decimal, 8
digits

Decimal, 8
digits

Decimal, 8
digits

Decimal, 8

digits
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Enroliment
.specialEdSetting

CustomEnrollment
sped.occupationalHours

CustomEnrollment
sped.physicalHours

CustomEnrollment
sped.psychologicalHours

CustomEnrollment
sped.counselingHours

CustomEnrollment
sped.socialWorkHours

Transforming K12 Education®

Student
Information >
General >
Enrollments >
Special Ed Fields
> Special Ed
Category

Student
Information >
General >
Enrollments >
Special Ed Fields
> Occupational
Therapy Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> Physical
Therapy Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> Psychological
Therapy Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> Counseling
Services Hours

Student
Information >
General >
Enroliments >
Special Ed Fields
> Social Work
Services Hours



Audiological
Therapy Hours

Recreational
Therapy Hours

School Health
Hours

Speech Therapy
Hours

SPED
Transportation

Other Service
Hours

SPED Assistive
Technology

Number of hours
student
participated in
audiological
services. Round
to 3 decimals.

Number of hours
student
participated in
recreational
therapy. Round to
3 decimals.

Number of hours
student
participated in
school health
services. Round
to 3 decimals.

Number of hours
student
participated in
speech/language
therapy. Round to
3 decimals.

Indicates whether
student is
receiving
transportation
assistance.

Number of hours
student
participated in
other services.
Round to 3
decimals.

Indicates whether
student is
receiving assistive
technology
services.

Decimal, 8 CustomEnrollment
digits sped.audiologicalHours
Decimal, 8 CustomEnrollment
digits sped.recreationalHours
Decimal, 8 CustomEnrollment
digits sped.schoolHealthHours
Decimal, 8 CustomEnrollment
digits sped.speechHours
Alphabetic, 1 =~ CustomEnrollment
character sped.transportation
YorN
Decimal, 8 CustomEnrollment
digits sped.otherServiceHours
Alphabetic, 1 ~ CustomEnrollment
character sped. assistiveTechnology
YorN
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Student
Information >
General >
Enrollments >
Special Ed Fields
> Audiological
Services Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> Recreational
Therapy Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> School Health
Services Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
>
Speech/Language
Therapy Hours

Student
Information >
General >
Enroliments >
Special Ed Fields
>Transportation

Student
Information >
General >
Enroliments >
Special Ed Fields
> Other Service
Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> Assisstive
Technology



Orientation
Mobility Hours

Special Ed
Program

Primary
Disability

Multiple
Disability 1

Multiple
Disability 2

Number of hours
student
participated in
orientation
mobility therapy.
Round to 3
decimals.

Code indicating
the type of special
education
program in which
the student is
participating. If
Special Ed
Program is
entered, SPED
Start Date must
not be empty.

See Special Ed

Program Codes
Table below.

Student's primary
disability. If
Primary Disability
is entered, SPED
Start Date must
not be empty.

See Disability
Codes Table
below.

Student's
disability in
addition to
Primary Disability.

See Disability
Codes Table
below.

Student's
disability in
addition to
Primary Disability.

See Disabilit
Codes Table
below.

Decimal, 8 CustomEnrollment
digits sped.orientationHours
Alphabetic, 1  Enroliment.

character specialEdStatus

Alphanumeric,
3 characters

Enrollment.disabilityl

Alphanumeric,
3 characters

Enrollment.disability2

Alphanumeric,
3 characters

Enrollment.disability3
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Student
Information >
General >
Enrollments >
Special Ed Fields
> Orientation
Mobility Hours

Student
Information >
General >
Enrollments >
Special Ed Fields
> Special Ed
Program

Student
Information >
General >
Enrollments >
Special Ed Fields
> Primary
Disability

Student
Information >
General >
Enroliments >
Special Ed Fields
> Multiple
Disability 1

Student
Information >
General >
Enrollments >
Special Ed Fields
> Multiple
Disability 2



Multiple
Disability 3

Multiple
Disability 4

Multiple
Disability 5

SPED Start
Date

SPED End Date

SPED Exit Code

Student's
disability in
addition to
Primary Disability.

See Disability
Codes Table
below.

Student's
disability in
addition to
Primary Disability.

See Disability
Codes Table
below.

Student's
disability in
addition to
Primary Disability.

See Disability
Codes Table
below.

Beginning date of
Special Education
program
participation.

Ending date of
Special Education
program
participation.

Exit code
attached to the
ending of the
student's special
education
participation.

See Special Ed
Exit Codes Table

below.

Alphanumeric,
3 characters

Alphanumeric,
3 characters

Alphanumeric,
3 characters

Date field, 10
characters
MM/DD/YYYY

Date field, 10
characters
MM/DD/YYYY

Numeric, 10
digits
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Enrollment.disability4

Enrollment.disability5

Enrollment.disability6

Enrollment.spedStartDate

Enrollment.spedExitDate

Enroliment.
spedExitReason

Transforming K12 Education®

Student
Information >
General >
Enrollments >
Special Ed Fields
> Multiple
Disability 3

Student
Information >
General >
Enrollments >
Special Ed Fields
> Multiple
Disability 4

Student
Information >
General >
Enrollments >
Special Ed Fields
> Multiple
Disability 5

Student
Information >
General >
Enrollments >
Special Ed Fields
> Effective Date

Student
Information >
General >
Enrollments >
Special Ed Fields
> End Date

Student
Information >
General >
Enrollments >
Special Ed Fields
> Exit Code



Days Absent

Title 1 Status

Citizenship

Transportation

Homeless

Number of days
student was
absent.

Indicates whether
student is
participating in
title 1 services.

Code indicating
student's
citizenship status.

See Citizenship
Codes Table

below.

Indication of
transportation
assistance
provided to the
student, if
applicable.

See
Transportation
Codes Table
below.

Indicates
student's
homeless status.
If student was
homeless at any
point during the
school year, field
should remain
populated even if
student is no
longer homeless.

See Homeless
Status Codes
Table below.

Decimal, 8
digits

Alphabetic, 1
character

Y or N

Numeric, 1
digits

Numeric, 2
digits

Alphanumeric,
1 character
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Calculated, not
dynamically stored

Enrollment.titlel

Enrollment.citizenship

Enrollment.transportation

Enrollment.nomeless

Transforming K12 Education®

Student
Information >
General >
Enrollments >
State Reporting
Fields > Absent
Days

Student
Information >
General >
Enrollments >
State Reporting
Fields > Title 1

Student
Information >
General >
Enrollments >
State Reporting
Fields >
Citizenship

Student
Information >
General >
Enrollments >
State Reporting
Fields >
Transportation
Category

Student
Information >
General >
Enrollments >
State Reporting
Fields >
Homeless Status



Unaccompanied
Youth

Title 1 Math

Title 1 Reading

Title 1 Science

Title 1 Social

Science

Title 1
Vocational

Indicates the
student is not in
the presence of a
parent, guardian
or legal status
identified by the
court system.

Indicates
student's
participation in
Title 1 Math
program.

Indicates
student's
participation in
Title 1 Reading
program.

Indicates
student's
participation in
Title 1 Science
program.

Indicates
student's
participation in
Title 1 Social
Science program.

Indicates
student's
participation in
Title 1 Vocational
program.

Alphanumeric,
1 character

Alphabetic, 1
character

Y orN

Alphabetic, 1
character

Y or N

Alphabetic, 1
character

Y orN

Alphabetic, 1
character

Y or N

Alphabetic, 1
character

Y or N
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Enrollment.
mvUnaccompaniedYouth

EnrollmentSD.title1Math

EnrollmentSD.
tittel1Reading

EnrollmentSD.title1Science

EnrollmentSD.
tittelSocialScience

EnrollmentSD.
titlelVVocational

Transforming K12 Education®

Student
Information >
General >
Enrollments >
State Reporting
Fields >
Unaccompanied
Youth

Student
Information >
General >
Enrollments >
State Reporting
Fields > Title 1
Math

Student
Information >
General >
Enrollments >
State Reporting
Fields > Title 1
Reading

Student
Information >
General >
Enrollments >
State Reporting
Fields > Title 1
Science

Student
Information >
General >
Enroliments >
State Reporting
Fields > Title 1
Social Science

Student
Information >
General >
Enrollments >
State Reporting
Fields > Title 1
Vocational



Title 1 Health Indicates Alphabetic, 1  EnrollmentSD.title1Health Student
student's character Information >
participation in General >
Title 1 Health YorN Enrollments >
program. State Reporting

Fields > Title 1
Health/
Dental/Eye Care

Title 1 Guidance Indicates Alphabetic, 1  EnrollmentSD. Student
student's character tittelGuidance Information >
participation in General >
Title 1 Guidance Y orN Enrollments >
program. State Reporting

Fields > Title 1
Supporting
Guidance

First Year In Indicates that this ~ Alphabetic, 1  EnrollmentSD. Student

Country enroliment character firstYearinCountry Information >
represents the General >
student's firstyear Y or N Enrollments >
in the country. State Reporting

Fields > First
Year in Country

Date Entered The date the Date field, 10  Identity. Census > People

US Schools student enrolled in  characters dateEnteredUSschool > Demographics
a US school. MM/DD/YYYY > Data Entered

US Schools

Diploma Type The student's Alphanumeric, Graduation.diplomaType Student
graduation 2 characters Information >
diploma type. General >

Graduation >
Reporting values Diploma Type
are as follows:
® 1: Regular
Diploma

Diploma Date The date the Date field, 10  Graduation.diplomaDate Student

student received characters Information >
MM/DD/YYYY General >

Graduation >

Diploma Date

Year The end year of Date field, 4 Calendar.endYear System
the enroliment ( characters Administration >
i.e. for Calendar >
SY2006-2007 = YYYY Calendar >
2007). Calendar Info

Example:

A student record for Kelsey Kramer.

12345 12 123 Kelsey Ann Kramer 10/11/1991 F WH
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123456789 223456789 F 10 22345 32345 08/26/2006

P 100 12T

N

N N

25 N 1 1 D N N N N
N N N 2007

Codes and Descriptions
The following tables define codes used in the file upload.

Special Ed Category Codes

Code Description

0100 General Class with Modifications 80-100%
0110 Resource Room 40-79%

0120 Self-Contained Classroom 0-39%
0130 Separate Day School

0140 Residential Facility

0150 Home/Hospital

0315 Early Childhood Setting 80-100%
0325 Early Childhood Setting 40-79%
0330 Early Childhood Setting 0-39%
0335 Separate Class

0345 Separate School

0355 Residential Facility

0365 Home

0375 Service Provider Location
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Special Ed Program Codes

Code Description

Mild to Moderate Disabilities
Severe Disabilities

Speech Only

Early Childhood

Day Program

Residential Program

& M m O O W »

Homebound Program

Primary Disability Codes

Code Description

500 Deaf-Blindness

505 Emotional Disturbance
510 Cognitive Disability

515 Hearing Loss

525 Specific Learning Disability
530 Multiple Disabilities

535 Orthopedic Impairments
540 Visual Loss

545 Deafness

550 Speech/Language

555 Other Health Impairment
560 Autism

565 Traumatic Brain Injury

570 Developmental Delay
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Enrollment Status Codes

Code Description

A
D
B

School Choice
Persistently Dangerous

Placed and Paid by Tribal
Contracting Student

Placed and Paid by DSS
Whole Grade Sharing

Placed and Paid by Corrections
Parentally Placed in Private
School

Open Enroliment

Tuition Paid by District

Tuition Paid by Other

Tuition Waived

Only Valid If

Only Valid If Resident District Same As Attending District

Only Valid If Resident District Same As Attending District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District

Only Valid If Resident District Different From Attending
District
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Multiple Disability Codes

Code Description

505 Emotional Disturbance
510 Cognitive Disability

515 Hearing Loss

525 Specific Learning Disability
535 Orthopedic Impairments
540 Visual Loss

545 Deafness

550 Speech/Language

555 Other Health Impairment
560 Autism

565 Traumatic Brain Injury

570 Developmental Delay
Special Ed Exit Codes

Code Description

Not receiving SE services
Graduated (high school diploma)
Reached the maximum age

Died

Moved, known to be continuing
Moved, not known to be continuing

Dropped out

© 00 N o o b~ N P

Refused services

=
o

ISFP done before max age/Pt C

=
=

Change in IEP

[EEY
N

Student Continues

28

Transforming K12 Education®



Race Ethnicity Codes

Code Description

AS
BL
HI
IN
Pl
TR
WH

Asian

Black, not Hispanic

Hispanic

American Indian or Alaskan Native
Native Hawaiian or Pacific Islander
Two or more races

White, not Hispanic

Citizenship Codes

Code Description

1
2
3

US Citizen
Foreign Exchange Student

Immigrant or Refugee

Transportation Codes

Code Description

01
02
03
04

Student Not Transported
Student Transported on District-Owned Buses
Student Transported on Contracted Buses

Mileage Paid in Lieu of Transportation

Homeless Status Codes

Code Description

D

c H T m

Doubled Up/Sharing Housing
Emergency/Transitional Shelter
Hotels/Motels

Transitional Housing

Unsheltered
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Service Type Codes

Code Description

P Primary
S Partial
N Special Ed Services

Suffix Codes

Code
Jr.
Sr.

I

I

1

v

vV

VI

VIl
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